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An overview of the design, analysis, manufacturing, and testing of systems motivated by
the Spaceport America Cup are presented. These systems, specifically the Ascent and
Recovery System (ARS), the Fin Retainment System (FRS), the Steerable Parachute System
(SPS), and the Avionics Vehicle Package (AVP) address the major technical challenges of the
2023 Spaceport America Cup and Space Dynamics Laboratory (SDL) Challenge: flight to a
precise altitude target, development of a payload that performs a relevant function, and
recording of relevant flight performance data for later analysis and the provision of valuable
learning opportunities.

I. Nomenclature

A = amplitude of oscillation

a = cylinder diameter

G = pressure coefficient

Cx = force coefficient in the x direction

Cy = force coefficient in the y direction

c = chord

dt = time step

Fx = X component of the resultant pressure force acting on the vehicle
Fy = Y component of the resultant pressure force acting on the vehicle
fg = generic functions

h = height

i = time index during navigation

J = waypoint index

K = trailing-edge (TE) nondimensional angular deflection rate
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II. Introduction
A. Document Description

This document serves as a comprehensive design description for River City Rocketry’s launch vehicle,
payload, and additional auxiliary systems that will be used to compete in the prestigious Spaceport
America Cup Intercollegiate Rocket Engineering Competition (IREC). In this report, we will delve into
the various design features that our team selected as well as the testing and validation performed. This
document will be scored for the competition and serve as a reference for future team members from the
2023 Spaceport Team. For any future member reading this document, we wish that this document will
serve you well and wish you luck in your current mission.

B. 2023 Endeavors

The 2022-2023 team has aimed to build an autonomous steerable parachute payload, develop a
pressure-fed kerosene-liquid oxygen rocket engine, create a multi-system condition monitoring and
tracking telemetry system, develop an L2 rocket flight vehicle for low-cost subsystem test flights, and
develop a full-scale rocket flight vehicle for the 2023 Spaceport America Cup competition. The telemetry
system, steerable parachute system, and full-scale rocket flight vehicle will be showcased during
competition in the 2023 Spaceport America Cup. The liquid engine will serve as a development platform
that the team can expand on going into the future, and the L2 test vehicle will remain available for flight
tests of complete future subsystems.

C. Team Organization

The team’s design for the Spaceport America Cup is the result of effective team organization and
collaboration. We boast a multidisciplinary team which consists of passionate individuals from various
fields of study including mechanical engineering, electrical engineering, computer science engineering,
and communications. The team structure consists of members in team leadership, an avionics sub-team, a
payload sub-team, an acrostructures sub-team, and propulsion sub-team. By fostering an organized and
collaborative team structure, we have been able to capitalize on each team member’s strengths and
expertise, resulting in a cohesive and efficient design process. Our vision for excellence, and effective
teamwork have been integral to the development of a competitive rocket design for the Spaceport
America Cup Competition. The 2023 team organization is shown below in Figure 1.
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Fig. 1 Leadership Org Chart
III. System Architecture Overview

The presented work consists of four subsystems which are assembled to achieve the competition goals.
Starting from the aft of the flight vehicle and referencing the subsystems shown in Figure 2, the vehicle
consists of the COTS propulsion system, the Fin Retainment System (FRS), the Ascent and Recovery
System (ARS), the Avionics Vehicle Package (AVP), and the Steerable Parachute System (SPS). The
COTS propulsion system provides the energy necessary to launch the vehicle to its target altitude. The
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Fin Retainment System provides a rigid fixture to mount the fins and transmit aerodynamic loads from
the fins into the aft of the flight vehicle. This system also allows the fins to be easily removed for
transport and replaced between flights if damage occurs. The Ascent and Recovery System both provides
the support structure which contains all other subsystems, and a single bay dual deployment parachute
system to safely recover the flight vehicle after flight. The Avionics Vehicle Package records information
about the states of other subsystems and transmits that information to the ground crew, allowing informed
GO/NO-GO decisions on the pad and remote monitoring of battery levels during waiting periods on the
pad. The Steerable Parachute System is the primary competition payload and is deployed in flight before
guiding itself to a GPS coordinate on the ground by adjusting the lengths of the cords attaching it to a
cruciform parachute.

Fig. 2 Section view of flight assembly showing each subsystem

A. Propulsion Subsystem

The team will use a Cesaroni N5600 commercial reload in a Cesaroni Pro98 6G casing, with a double-
headed igniter from AMW used for ignition. A custom plate below the motor is used for motor retainment.
This motor was chosen because it was already owned by the team. The same reload was used in the team’s
2022 season. This year, the vehicle is smaller and lighter and using a much smaller motor would have been
preferable if one was available, but this motor was already owned by the team, and with no other planned
projects requiring an N motor, the on-hand, zero-cost option was the clear choice. Because of this motor
choice, significant extra weight was required in the vehicle design to reach the desired apogee of 10,000 ft.
According to thrustcurve.org, the motor has an impulse of 13,628 N*s, a maximum thrust of 6789 N, a burn
time of 2.4s, and zero reported failures in the Malfunctioning Engine Statistical Survey. Because of the
relatively high maximum thrust, care was taken on the thrust structure of the rocket to ensure proper transfer
of thrust to the entire vehicle. These efforts are detailed in the Aero-structures Subsystem below.

B. Aero-Structures and recovery Subsystem

i. Vehicle subsystem

Forward pass is a 6-inch diameter rocket with a total length of 164 inches, a wet mass of 103 Ibs, and a
dry mass of 78.1 lbs. Initial open rocket models showed that a high weight was necessary for reaching the
apogee goal of 10,000 ft with the selected motor. Forward pass consists of 4 sub-assemblies. These sub-
assemblies are the booster section, recovery section, upper section, and the payload nosecone. All
airframe components (body tubes, coupler tubes, shoulders, etc.) are made from G12 fiberglass purchased
from Wildman Rocketry [] or an equivalent source. Fiberglass was chosen for its strength, weight, and RF
transparency. These tubes were proven to be effective at handling the forces of the same motor and
similar deployment conditions in both spaceport 2022 on and a prior test launch. The 6-inch inner
diameter was chosen to give workable clearances for inside components.

Booster section
The booster section of the rocket is comprised of a welded fin retainment and thrust plate system,

replaceable fins, a 50-inch body tube, and coupler containing a sand ballast system. Separated from the
rest of the vehicle, the booster section has a total height of 58 inches and a dry mass of 40.6 lbs.
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In previous vehicles, it was decided to design the fins to be replaceable instead of epoxying them directly
to the body tube. This allows for the booster body to be salvaged if any damage occurs to the fins upon
landing. Previous systems included exterior mounting brackets that added drag and instability, or many
internal machined parts that were found to be cumbersome and inconvenient to assemble. To subvert
these problems, Forward passes replaceable fin system is designed to be fully internal and welded, both to
add rigidity and ease the assembly process. The fin retainment system also constrains the motor and
transmits the thrust to the rest of the vehicle. Located at the aft of the booster section, the welded fin
retainment system includes the thrust plate, angles, the inner ring angle mount, and the fore ring.

All components are made from Hot rolled steel for ease of welding, availability, and added mass. The
motor slides into the innermost hole of the thrust plate and through the rest of the assembly, with the
thrust plate, inner ring angle mount, and fore ring all acting as centering rings. Located at the aft of the fin
retainment system, the thrust plate transmits the force of the motor to the rest of the structure through the
contact interference between it and the aft closure of the motor. To appropriately fit up the angle pieces,
the thrust plate has cuts that the angles slot into during welding. There are also 3 %4-20 tapped holes to
bolt a motor retainment plate that clamps the motor down so it doesn’t slide out after burn. Additional
cuts are made to save weight at the aft of the rocket and shift the center of gravity further up.

The angles are used to clamp down on the fin tabs and hold the fins in place during launch. The faces of
the angles are spaced out 4" using the same material the fins are made from, then welded to the thrust
plate as a base to achieve as tight of a fit as possible. The angle pieces have 4 %" clearance holes, with
one angle piece having nuts welded on the outside of the holes. %" bolts will pass through the angle and
fin holes,

(Andrew: Fully describe the vehicle, its design, include renderings of components/subassemblies, include
FEA analysis of critical components, and outline design rationale, assumptions, tradeoffs, etc.)

ii. Recovery subsystem

(Andrew: Fully describe the recovery system, discuss the design choices made, and include schematic
diagrams or similar of its layout. Discuss some of the tradeoffs made, and potentially find
renderings/images of the chutes from previous team documentation)

C. Payload Subsystem

River City Rocketry has chosen to answer the 2022-2023 Space Dynamic Laboratory Payload challenge
by designing and building a payload capable of altering its trajectory after being deployed from the rocket
called the Steerable Parachute System (SPS for short). The payload will be falling under a custom-made
cruciform parachute that is actuated using two DC servo motors to change the angle of attack of the
parachute. Each motor can affect the parachute and move the descending payload in its respective
orthogonal axis to navigate the payload to a predetermined location.

Overview picture of the assembly here

The SPS is housed in the nosecone section of the rocket with the shroud lines connecting the SPS to the
parachute going through the bulk plate. The parachute is stored in a parachute bag, which is attached to a
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pusher cup aft of the nose cone and parachute. To ensure the payload parachute inflates a safe distance
from the rocket, a 86 ft nylon cord is used to connect the pusher cup to the body of the rocket which will
act as a hard stop to pull the parachute bag off the parachute. This pusher cup also allows the SPS and
parachute to deploy consistently.

i. Payload Mechanical Overview

The SPS is comprised of four major sections: the pusher cup, the cord routing system, the control gear
system, and the electronics as seen on figure #.

SPS assembly here

One of the critical issues the team identified as a hazard for the SPS was the potential for its parachute to
be tangled with the body of the rocket immediately after deployment. To address this issue, the team
designed a pusher cup system to delay the opening of the SPS’s parachute unit it was at least 86 ft away
from the main body of the rocket. This length of shock cord was chosen as it is the distance between the
lowermost point of the payload body tube and the lowermost section of the booster +10 ft as seen on
figure ##.

Deployment picture

The pusher cup is made from a 6-inch-long coupler with a G10 Fiber glass bulkhead attached to the aft
section. The aft side of the bulkhead has a U-bolt with a 86 ft section of braded Kevlar rope rated for 800
Ibs of force. The fore section of the bulkhead has a brace in which the parachute bag is secured. The
parachute bag is undersized for the parachute to prevent smaller forces from prematurely deploying the
parachute as it is falling.

Drawing for Pusher cup

The cord routing system is comprised of a top aluminum bulk plate, a plexiglass blast shield, and a
custom-made mount (cord route mount) used to hold a camera and the key switch. The cord route mount
also guides the shroud line to prevent harsh bending angles against sharp edges of the aluminum plate.
The mount also serves to hold the fore GPS antenna required for section ##.

Drawing for the Custom Mount

The bulk plate and blast shields were chosen to be made from aluminum and plexiglass respectively due
to the high force generated by the black powder and aluminum being easy to machine with.

Calculate the Force acting on the BP, pusher cup and bulk plate
Cord routing system

The cord routing system

SPS Gears

The payloads movement is controlled by two sets of gears that manipulate the lateral and longitudinal
movements of the parachute. The sets of gears are separated into an upper and lower section separated by
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a divider plate. The lower set of gears controls the lateral movement while the upper set controls the
longitudinal. Each set of gears has their own custom cord routing system which routes the cords along the
circumference of the disks twice before fixing one end to the corresponding aluminum plate. This creates
a loop for the gear to actuate as seen in figure ##.

Cord routing system
This cord routing creates a moveable pulley system where an aluminum dowel acts as the pulley such that
the cord length moves twice the distance compared to the angular rotation of the gear. This was chosen to

maximize the range of useable cord length to give the payload more control authority.

Show the angle difference between the double routed vs singular routed

The cord routes are custom resin ﬁrinted iieces with a slit cut out of the tOﬁ cord route. F

Image of the cord routes

The gears used are two sets of identical gear sizes with the driven gear being 68 teeth and the pinion gear
being 16 teeth. The diametral pitch is a custom value determined by the distance between the center of the
driving motor to the center of the rotating shaft. This method was chosen to minimize the distance
between the edge of the motor to the edge of the plate the motor is mounted on.

Show assembly of the gears meshing

The diametral pitch was found using:

Equation to find DP

And was taken up to 5 significant figures of accuracy.

The tooth count of the pinion and driven gear are constrained by the root chord thickness and the

projected output torque of the driven gear. The maximum tooth count was determined to comply with
waterjet accuracy guidelines which prevented a minimum geometric feature of 1/8" of an inch. Using

The maximum allowable tooth count was calculated to be: ##teeth

On the other hand, the minimum tooth count was determined to ensure the resulting torque output on the
driven gear was at least three times greater than the expected torque to prevent back-driving of the motor.
This guideline was recommended by THE NASA THINGY.

The torque acting on the gear was calculated using the force generated by a cruciform parachute carrying
an 11 1b weight descending at 20ft/s. This force was multiplied by the radial distance between the pivot
point and the center of the gear to get the expected torque of the shroud lines.

Stress analysis for Tooth loads
The team chose to water jet the gear due to the unique nonstandard diametral pitch needed to main the

maximum distance between the gear sets. The water jet also enabled the gears to have a more custom
profile to tailor itself to the limit switch integration and cord mounting. The driven gear was split into two

6
Experimental Sounding Rocket Association



identical ¥4", 6061 aluminum plates which were press together via aluminum dowels and a hydraulic press
as seen in figure ##. The drive gear was manufactured in two pieces to avoid material tapering. This was
deemed necessary as we found material tapering in a solid %2" plate.

Gear Assembly
Gear Drawings

To reduce the friction between the Mild Steel Hot rolled center shaft and the gears, Koyo R16-2RS sealed
ball bearing were pressed into the ID of the drive gears.

Ball Bearing drawing

The centering shaft acts as the main form of mounting the payload. Apart from acting as the axis in which
the drive gears rotate, it also acts as the main attachment point between the nosecone and the SPS. To
minimize drag, three low-profile bolts are mounted though the shoulder of the nosecone and into the
centering shaft. The centering shaft also accommodates three all-thread to axially lock the control system
plates. The centering shaft is made of a hollow 17 diameter pipe welded to a /2" water jetted plate. This
design allows the payload electronics wires to connect motors without snagging or tangling issues with
the gears.

Center Shaft drawing

(Branden: Fully describe the mechanical design of the Payload, include renderings of
components/subassemblies, include FEA analysis of critical components, and outline the design rationale,
assumptions, tradeoffs, etc.)

ii. Payload Electrical Overview
(Keeton & Alex)

(Keeton and Alex: Fully describe the electrical design of the Payload and the Avionics battery pack,
include circuit schematics, board layouts, and renderings of the battery design, discuss the control code,
outline the rationale behind design choices, sensor selection, assumptions made, design tradeoffs, etc.)

The payload electrical system oversaw the power of the whole rocket during pre-flight. We decided to do
this via 2 batteries, 1 in the body of the rocket for general power, and another attached to the payload to
power it post deployment. The battery chemistry for both is LiFePo4 because it is known for its high
stability in a wide range of temperature as well as its high impact resistance.

The large battery in the body of the rocket is a 5s6p meaning its 5 cells in series for a total voltage of 16V
and 6 sets in parallel for longer life. This gives us about 13.5-amp hours of battery life (2.3 Ah/cell
*6cells). With our system drawing .25 for payload and an estimate of 1.25 amps for the rest of the vehicle
on average. This battery can power the rocket for a total of 9 hours after arming which was deemed
necessary after conservative estimates based on previous launches delays and scrubs.

Once the rocket vehicle is completely assembled and armed, the batteries will be operating until launch.
Due to the high temperatures of the surrounding environment along with the heat produced by the
batteries, the possibility of system failure due to overheating was investigated. As a result, the
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implementation of an active cooling system was chosen. The current design includes two F.D.M. printed
parts which will serve to constrain and organize the battery cells. This system will be further isolated
inside an airtight capsule to ensure no pressure differences influence nearby altimeters. This is critical due
to the sensitivity of the altimeters. Failure to take this into account may give rise to the parachutes of the
vehicle deploying too early or late.

This system will be controlled with a fan talking to the avionics system in section ## [GARRETT]

The payload battery is a 4s4p providing 12v to the payload. This voltage was chosen to be large enough to
power the motors, then the larger battery was chosen to be 1 cell larger to create a voltage differential.
This voltage differential is used with a diode to allow an amazingly simple system to stop the payload
battery from being used until the main battery is disconnected, see figure #. Then as many parallel as
could fit in 1 layer of the rocket for a longer life during flight and on pad in case of main battery failures.

Battery management fig

Battery charging procedure: SELF NOTE FOR KEETON SO I KNOW THIS ISNT A FIGURE AND
ACTUALLY A PARAGPACH I NEED TO WRITE ABOUT BATTERY STUFF.

The rest of the payload electronics are in the electrical bay of the payload, See figure #. There is 4 main
parts. PCB, motor controllers, Antenna, IMU. The PCB includes multiple sensors and the raspberry pi.
There are 2 motor controllers on the second level along with an antenna for the GPS. Finally at the top
level there is an IMU.

Payload cross section figure

The PCB can be broken down into 5 more sub parts. _
WSRO A full picture of the schematic is provided below with these 5 sections clearly defined,
see figure #.

Full schematic figure

1. The first section is the GPS. This consists of the GPS module and an IC to control the switching of
antennas. In our system, we have 2 antennas. The first is used to get a GPS fix as the rocket ascends. Then
after the rocket reaches apogee it flips, and the second antenna is used. We deemed this necessary after
some preliminary testing and decided that the large metal mass that is the payload blocks most signals
from going through it. See figure # for the schematic of the switch.

GPS circuit and switch fig

1. Sensors, there are 3 devices in this section, the BNO, BMP, and transceiver. The BNO, or IMU, is a
9-axis orientation unit. This sensor allows us to get a relative and absolute heading of the payload. This
device allows us to direct toward the ending point. Next is the BMP, this device gives us the height of the
payload, so we know our altitude allowing us to decide how aggressive we want to steer. Lastly the
transceiver is to allow for recovery as we broadcast our position to the ground station and allow
communication during flight of all system.
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iii. The raspberry Pi section contains the 40-pin header of the raspberry pi along with all the
pulldown/pullup resistors for each GPIO pin. All the GPIO pins used for reading motor inputs as well as
output from the pi that are not standardized (i.e., not i2C, UART, or SPI) are pulled down. Then the i2C
bus is pulled high. Lastly there is also a voltage divider coming in from the main 16V battery to detect
when the main battery as been disconnected indicating deployment to the pi, see figure # for the pi circuit.

Pi Fig

iv. The motor section of the PCB consists of only headers. There are 8 headers in total. 2 for encoders,
4 for limit switches, and 2 for the PWM signal going to the motor controller. Due to the high-power
requirement of motors the power running to the motors is done directly from the battery, check figure #
for a diagram.

Motor fig.

v. Lastly is the power section. This takes in both batteries. They both immediately feed into a diode so
that the 16V can back feed the 12V stopping it from turning on until the 16V is disconnected. The diode
then feeds into a 5V regulator. This regulator has an EMC circuit. This is to stop any interference from
the power system affecting the other sensors and antennas. The whole board runs on either this 5V power
or the 3.3V provided by the Pi. See fig # for the full power circuit including the EMC circuit.

Power fig

POLOAD CODE EXPLINATION START

D. Avionics Subsystem
(Garrett: Fully describe the design and implementation of the Avionics, include circuit schematics, board

layouts, and renderings of components as applicable, discuss software implementation and the ground
station, including assumptions made, design tradeoffs, system capabilities and limitations, etc. )

IV. Mission Concept of Operations Overview
(Gerhardus)
V. Conclusions and Lessons Learned

In the course of developing the systems for this year’s Spaceport America Cup competition, the team
faced multiple organizational and project management challenges and generated several valuable lessons
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learned. By comparison, the technical challenges were relatively minor, but valuable takeaways were still
found. The organizational lessons-learned have been subdivided into team management insights and
knowledge transfer strategies.

During the previous competition year, one of the primary team management challenges faced by the team
was a lack of centralized decision-making authority. We had two co-captains with equal authority and no
division between administrative and technical responsibilities. This system resulted in numerous
communication failures, problems with leadership members countermanding each other, a lack of a
cohesive systems-level vision for the competition hardware, and a failure to create and follow a coherent
schedule, among other issues. Considering this, during this year, we implemented a more centralized
system consisting of a single team captain responsible for all administrative and financial tasks and a
systems engineer responsible for all technical planning and technical executive decision-making. This
new system greatly improved the efficacy of our communications and established singular roles which
would make the final call if an impasse occurred between technical sub-teams. Unfortunately, since this
organizational system was new to us, there wasn’t a previous legacy of how things should be done, and
multiple challenges were discovered and resolved.

One of the major early systems engineering challenges was a tendency to overcomplicate the flight
systems. Most individual team members had their own specific interests, and would get to add features,
add desired capabilities, or otherwise put their own touch on their subteams’ systems. Each individual
additional feature was manageable and therefore approved, but the cumulative impact of the added
features was an unrealistic degree of complexity. As a consequence of this complexity, the team started
the Fall semester with a 30,000 foot COTS architecture including a variable airbrake system, a CO2 cold
gas thruster system for apogee adjustment at low speeds, a vehicle-wide serial communication, power
management, and telemetry system, and a deployable steerable parachute system capable of aiming for a
specific landing location. As the semester progressed, it started becoming clear that some systems would
not reach completion before the June competition. In response, the cold gas thruster system was deleted.
Shortly following this, financial pressure due to unforeseen changes with one of our sponsors forced a
descope to a cheaper 10,000 foot COTS architecture. In the early Spring semester, the airbrake system
was also deleted, and substantial ballast mass was added to the vehicle to bring the simulated apogee
down to 10,000 feet. Since both the airbrake and cold gas thruster systems had been removed, a simple
reaction wheel for roll control was added to the aft ballast compartment which previously housed the
airbrake system. This system gave the people who were displaced from the airbrakes and cold gas
thrusters something interesting to work on but was ultimately also removed a few months later when it
started experiencing excessive schedule slip. The consequence of this drawn-out progressive descoping,
modification, and partial rescoping of the system was considerable wasted time, resources, and energy.
Additionally, deleting people’s systems after they slipped a few times has a significant negative impact on
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team morale, which both causes people to reallocate more of their energy to classes and other obligations,
and causes burnout which reduces each person’s productive output

The technical challenges faced by the team were minor compared to the organizational challenges
Deadline leapfrogging — The more deadlines are missed, the less weight future ones carry.
Insurance costs
Recruiting, knowledge transfer and retention — professionalism
Divide organizational lessons-learned and technical lessons-learned
e Organizational lessons-learned
o Team management lessons-learned
= Try-fail-try-fail-repeat leapfrog strategy
=  Professionalism and planning strategy
=  Preemptive scope reduction strategy
= Documentation only works if it is used
o Knowledge transfer strategies

= Subsystem ownership — importance of passion — importance of interest catching
activities

= Instructional/teaching sessions
= Retraction to advisory roles before departure
= Increase carry-over of information and documentation from previous years
o Documentation only works if it is used
e Technical lessons-learned

o Composites manufacturing

(Gerhardus)
Appendix

A. System Weights, Measures, and Performance Data
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(Andrew, Branden, Keeton, Garrett: List your system info sections here)

B. Project Test Reports

(Andrew, Branden, Keeton, Garrett: Describe any tests you have conducted and the results of those tests)

C. Hazard Analyses

(Gerhardus: Do generalized and operations hazard analyses)

D. Risk and Failure Mode Analyses

(Andrew, Branden, Keeton, Garrett, Patrick: Do analyses for your subsystems)

Propulsion Risk Assessment Matrix

Hazard

Possible Causes

Mitigation Approach

Risk Level
After
Mitigation

Fragmentation of
motor components
from explosion
during flight

Voids or cracks present in
propellant grains

Grains will be inspected by team
members and Flyer of Record to
ensure high quality of grains.

Low

Motor assembled incorrectly —
closures not sealed correctly, etc

Motor will be assembled with the
help of Flyer of Record to ensure
correct assembly.

Low

Defect in casing or closure
manufacturing

Casing and closures will be
inspected prior to motor assembly
by both a team member and Flyer of
Record.

Low

Failure to ignite
motor

E-match not inserted into grain
core properly

Wait a minimum of 60 seconds
before approaching rocket to ensure
motor does not ignite. Once at
rocket, immediately disconnect
igniter from launch control
electronics. Only essential, fully
trained, and certified personnel go to
pad to inspect and replace (as
necessary) E-match.

Low

Motor ignition
occurs prematurely

Igniter was installed prematurely

Proper procedure and necessary
checklists will be followed precisely
during launch operations. This
includes not installing the igniter
into the motor until necessary, and
paying attention to competition staff
at all times.

Low
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(Gerhardus: Do analyses for operations and multiple-system failure modes)
E. Procedures and Checklists

(Andrew, Branden, Keeton, Garrett, Patrick: Put all of your procedures and checklists here)

Propulsion Procedure

Only initial step when it is fully completed and last step is also fully initialed. If any part of step is
incomplete do not initial. Positive and negative consequences ultimately fall on initial.

If previously completed step is realized or caused to be incomplete, restart checklist from top. DO NOT
initial for any steps not checked personally by initialer. DO NOT initial any others than your own.

Step DO NOT INSTALL IGNITER OR CLOSURES UNTIL INSTRUCTED!

Initial

At lodging: Assemble motor according to provided instructions up to, but no further than, grain-liner
gluing step. Store liner on end in place where it cannot fall over.

Before driving to launch site: Confirm completion of packing checklist. Insulate liner with blanket.

After arriving at launch site: Continue motor assembly according to provided instructions, including
installation of forward closure.

Prepare igniter: Pull igniter leads through hole in plastic nozzle cap. Twist igniter around igniter dowel.
Do not install igniter into motor.

When vehicle is ready for launch: Install aft closure. Install motor into vehicle.

Install motor retainment ring. Confirm secure installation of retainment ring.

Find and bring to launch site plastic nozzle cap, igniter, and this checklist. Pull igniter leads through
hole in plastic nozzle cap.

When vehicle is fully armed and OK given from Spaceport staff to install igniter: Install igniter into
motor. Ensure igniter reaches near forward closure. Install plastic nozzle cap onto nozzle.

Clack ignition system clips together before attaching to igniter leads, confirming lack of sparks. Connect
ignition system clips to igniter leads, gripping lead in clip then twisting lead around clip.

Ensure ignition system clips are spaced apart from each other and from any metal objects before
retreating from vehicle.

If vehicle must be disarmed: Disconnect igniter leads from ignition system clips. Remove plastic nozzle
cap. Remove igniter from motor.
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Ttem PROPULSION Initial  Box#/Car  otelf

Number applicable

1 CTI Pro98 wrench tool or other method/tools
2 Polyurethane glue
3 Bucket / washing container
4 Dish soap
5 Rags
6 Casing
7 Forward closure
8 2x Retaining ring (min)
9 Liner (per)
10 Forward disk insulator (per)
11 Igniter dowel (per)
12 Double-headed igniter (per)
13 Nozzle cap (per)
14 Nozzle (per)
15 O-rings (per)
16 Motor kit (per)
17 Motor instructions
18 Scrubby thing
19 Motor Retainer (or under vehicle)
20 Broomstick/wood dowel
21 IPA
22 Blankets for motor box vibration insulation
23 Disposable gloves
24 3x Procedure sheet

F. Engineering Drawings
(Andrew, Branden, Keeton, Garrett, Peyton, Alex: Put all component drawings here)

References

R
END OF REPORT, REFERENCE FORMATTING INFO BELOW

R R

VI. Procedure for Spaceport America Cup Technical Report Submission

On or before the date specified in the Integrated Master Schedule prior to the event, teams shall submit a single
digital PDF copy of their Project Technical Report. Technical reports exceeding 50 Megabytes in size may need to
be uploaded to a cloud server as long as the permissions allow the judges unrestricted access to the document.
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Teams shall submit their Project Technical reports using the HeroX website:
(https://www.herox.com/SpaceportAmericaCup2022).

Teams should bring a limited number of hardcopies to the Spaceport America Cup so members of the judging
panel and other competition officials may consult the contents at will during interactions with the team.

VII. General Guidelines and Required Elements
The following section outlines general (non-formatting) guidelines to follow. Technical reports will contain all
elements identified in Section 2.7.2 of the IREC Rules and Requirements document, which is available for download
on the ESRA website (http://www.soundingrocket.org/sa-cup-documents--forms.html). Missing or incomplete
elements will result in loss of points. The following required items are provided for quick reference and teams should
consult the Rules and Requirements for detailed guidance. Teams are permitted to add other technical elements at
their discretion. No table of contents is required, although teams will not be penalized for including one.

D. Report Body
1) Abstract
2) Introduction
3) System Architecture Review
4)  Mission Concept of Operations Overview
5)  Conclusion and Lessons Learned

E. Required Report Appendices
1) System Weights, Measures and Performance Data
2)  Project Test Reports
3) Hazard Analysis
4)  Risk Assessment
5) Assembly, Preflight, Launch, and Recovery Checklists
6) Engineering Drawings

F. List of References
References are required and must follow the format under “References” at the end of this document.

VIIl1.Detailed Formatting Instructions

The styles and formats for the AIAA Papers Template have been incorporated into the structure of this document.
If you are using Microsoft Word 2001 or later, please use this template to prepare your manuscript. Regardless of
which program you use to prepare your manuscript, please use the formatting instructions contained in this document
as a guide.

If you are using this template.dotx file to prepare your manuscript, you can simply type your own text over sections
of this document or cut and paste from another document and use the available markup styles. If you choose to cut
and paste, select the text from your original Word document and choose Edit>Copy. (Do not select your title and
author information, since the document spacing may be affected. It is a simple task to reenter your title and author
information in the template.) Open the template file. Place your cursor in the text area of the template and select
Edit>Paste Special. When the Paste Special box opens, choose “unformatted text” or “keep source formatting.” Please
note that special formatting (e.g., subscripts, superscripts, italics) may be lost when you copy your text into the
template. Use italics for emphasis; do not underline. Use the “Print Layout” feature from the “View” menu bar
(View>Print Layout) to see the most accurate representation of how your final paper will appear.

A. Document Text

The default font for the Project Technical Report is Times New Roman, 10-point size. In the electronic template,
use the “Text” or “Normal” style from the pull-down menu to format all primary text for your manuscript. The first
line of every paragraph should be indented, and all lines should be single-spaced. Default margins are 1” on all sides.
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In the electronic version of this template, all margins and other formatting is preset. There should be no additional
lines between paragraphs.

Extended quotes, such as this example, are to be used when material being cited is longer than a few sentences, or the
standard quotation format is not practical. In this Word template, the appropriate style is “Extended Quote” from the
drop-down menu. Extended quotes are to be in Times New Roman, 9-point font, indented 0.4 and full justified.

NOTE: If you are using the electronic template to format your manuscript, the required spacing and formatting
will be applied automatically, simply by using the appropriate style designation from the pull-down menu.

B. Headings

The title of your paper should be typed in bold, 24-point type, with capital and lower-case letters, and centered at
the top of the page. The names of the authors, business or academic affiliation, city, and state/province should follow
on separate lines below the title. The names of authors with the same affiliation can be listed on the same line above
their collective affiliation information. Author names are centered, and affiliations are centered and in italic type
immediately below the author names. The affiliation line for each author is to include that author’s city, state, and
zip/postal code (or city, province, zip/postal code and country, as appropriate). The first-page footnotes (lower left-
hand side) contain the job title and department name, and street address/mail stop for each author. Author email
addresses may be included also.

Major headings (“Heading 1” in the template style list) are bold 11-point font, centered, and numbered with Roman
numerals.

Subheadings (“Heading 2” in the template style list) are bold, flush left, and numbered with capital letters. Sub-

Subheadings (“Heading 3” in the template style list) are italic, flush left, and numbered (1. 2. 3. etc.)

C. Abstract

The abstract should appear at the beginning of your paper. It should be one paragraph long (not an introduction)
and complete in itself (no reference numbers). It should indicate subjects dealt with in the paper and state the objectives
of the investigation. Newly observed facts and conclusions of the experiment or argument discussed in the paper must
be stated in summary form; readers should not have to read the paper to understand the abstract. The abstract should
be bold, indented 3 picas (1/2”) on each side, and separated from the rest of the document by - blank lines above and
below the abstract text.

D. Nomenclature

Papers with many symbols may benefit from a nomenclature list that defines all symbols with units, inserted
between the abstract and the introduction. If one is used, it must contain all the symbology used in the manuscript,
and the definitions should not be repeated in the text. In all cases, identify the symbols used if they are not widely
recognized in the profession. Define acronyms in the text, not in the nomenclature.
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E. Footnotes and References

Footnotes, where they appear, should be placed above the 1” margin at the bottom of the page. To insert footnotes
into the template, use the Insert>Footnote feature from the main menu as necessary. Numbered footnotes as formatted
automatically in the template are acceptable, but superscript symbols are the preferred AIAA style, in the sequence,
*oF 5§ A T, T 88, ete.

List and number all references at the end of the paper. Corresponding bracketed numbers are used to cite references
in the text [1], unless the citation is an integral part of the sentence (e.g., “It is shown in Ref. [2] that...”) or follows a
mathematical expression: “A? + B = C (Ref. [3]).” For multiple citations, separate reference numbers with commas
[4, 5], or use a dash to show a range [6-8]. Reference citations in the text should be in numerical order.

In the reference list, give all authors’ names; do not use “et al.” unless there are more than 10 authors. Papers that
have not been published should be cited as “unpublished”; papers that have been submitted or accepted for publication
should be cited as “submitted for publication.” Private communications and personal website should appear as
footnotes rather than in the reference list.

References should be cited according to the standard publication reference style (for examples, see the
“References” section of this template). Never edit titles in references to conform to AIAA style of spellings,
abbreviations, etc. Names and locations of publishers should be listed; month and year should be included for reports
and papers. For papers published in translation journals, please give the English citation first, followed by the original
foreign language citation.

F. Images, Figures, and Tables

All artwork, captions, figures, graphs, and tables will be reproduced exactly as submitted. Be sure to position any
figures, tables, graphs, or pictures as you want them printed.

Do not insert your tables and figures in text boxes. Figures should have no background, borders, or outlines. In the
electronic template, use the “Figure” style from the pull-down formatting menu to type caption text. You may also
insert the caption by going to the References menu and choosing Insert Caption. Make sure the label is “Fig.,” and
type your caption text in the box provided. Captions are bold with a single tab (no hyphen or other character) between
the figure number and figure description.
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Fig. 1 Magnetization as a function of applied fields.

Place figure captions below all figures; place table titles above the tables. If your figure has multiple parts, include
the labels “a),” “b),” etc. below and to the left of each part, above the figure caption. Please verify that the figures and
tables you mention in the text actually exist. Please do not include captions as part of the figures, and do not put
captions in separate text boxes linked to the figures. When citing a figure in the text, use the abbreviation “Fig.” except
at the beginning of a sentence. Do not abbreviate “Table.” Number each different type of illustration (i.e., figures,
tables, images) sequentially with relation to other illustrations of the same type.

17
Experimental Sounding Rocket Association



Figure axis labels are often a source of confusion. Use words rather than symbols. As in the example to the right,
write the quantity “Magnetization” rather than just “M.” Do not enclose units in parenthesis, but rather separate them
from the preceding text by commas. Do not label axes only with units. As in Fig. 1, for example, write “Magnetization,
kA/m” not just “kA/m.” Do not label axes with a ratio of quantities and units. For example, write “Temperature, K,”
not “Temperature/K.”

Multipliers can be especially confusing. Write “Magnetization, kA/m” or “Magnetization, 10> A/m.” Do not write
“Magnetization (A/m) x 1000” because the reader would not then know whether the top axis label in Fig. 1 meant
16000 A/m or 0.016 A/m. Figure labels must be legible, and all text within figures should be uniform in style and size,
no smaller than 8-point type.

G. Equations, Numbers, Symbols, and Abbreviations

Equations are centered and numbered consecutively, with equation numbers in parentheses flush right, as in Eq.
(1). Insert a blank line above and below the equation. First use the equation editor to create the equation. If you are
using Microsoft Word, use either the Microsoft Equation Editor or the MathType add-on (http://www.mathtype.com)
for equations in your paper, use the function (Insert>Object>Create New>Microsoft Equation or MathType Equation)
to insert it into the document. Please note that “Float over text” should not be selected. To insert the equation into the
document:

1)  Select the “Equation” style from the pull-down formatting menu and hit “tab” once.

2) Insert the equation, hit “tab” again,

3)  Enter the equation number in parentheses.

A sample equation is included here, formatted using the preceding instructions. To make your equation more
compact, you can use the solidus (/), the exp function, or appropriate exponents. Use parentheses to avoid ambiguities
in denominators.

f: F(r.p)drde =[or/(2u,)]

[ exp(=Alz, =5 DA T (M) Jo(An)dA M

Be sure that the symbols in your equation are defined before the equation appears, or immediately following.
Italicize symbols (7 might refer to temperature, but T is the unit tesla). Refer to “Eq. (1),” not “(1)” or “equation (1)”
except at the beginning of a sentence: “Equation (1) is...” Equations can be labeled other than “Eq.” should they
represent inequalities, matrices, or boundary conditions. If what is represented is really more than one equation, the
abbreviation “Eqs.” can be used.

Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined
in the abstract. Very common abbreviations such as AIAA, SI, ac, and dc do not have to be defined. Abbreviations
that incorporate periods should not have spaces: write “P.R.,” not “P. R.” Delete periods between initials if the
abbreviation has three or more initials; e.g., U.N. but ESA. Do not use abbreviations in the title unless they are
unavoidable (for instance, “AIAA” in the title of this article).

H. General Grammar and Preferred Usage

Use only one space after periods or colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.”
Avoid dangling participles, such as, “Using Eq. (1), the potential was calculated.” [It is not clear who or what used
Eq. (1).] Write instead “The potential was calculated using Eq. (1),” or “Using Eq. (1), we calculated the potential.”

Use a zero before decimal points: “0.25,” not “.25.” Use “cm?,” not “cc.” Indicate sample dimensions as “0.1 cm
x 0.2 cm,” not “0.1 x 0.2 cm?.” The preferred abbreviation for “seconds” is “s,” not “sec.” Do not mix complete
spellings and abbreviations of units: use “Wb/m>” or “webers per square meter,” not “webers/m2.” When expressing
arange of values, write “7 to 9” or “7-9,” not “7~9.”

A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A
parenthetical sentence is punctuated within parenthesis.) In American English, periods and commas are placed within
quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not”
instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.”

If you wish, you may write in the first person singular or plural and use the active voice (“I observed that...” or
“We observed that...” instead of “It was observed that...”). Remember to check spelling. If your native language is
not English, please ask a native English-speaking colleague to proofread your paper.
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The word “data” is plural, not singular (i.e., “data are,” not “data is”). The subscript for the permeability of vacuum
Wo is zero, not a lowercase letter “0.” The term for residual magnetization is “remanence”; the adjective is “remanent”;
do not write “remnance” or “remnant.” The word “micrometer” is preferred over “micron” when spelling out this unit
of measure. A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is preferred to the word
“alternately” (unless you really mean something that alternates). Use the word “whereas” instead of “while” (unless
you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or “effectively.”
Do not use the word “issue” as a euphemism for “problem.” When compositions are not specified, separate chemical
symbols by en-dashes; for example, “NiMn” indicates the intermetallic compound NigpsMng s whereas “Ni-Mn”
indicates an alloy of some composition NixMnj.x.

Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun),
“complement” and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle”
(e.g., “principle of measurement”). Do not confuse “imply” and “infer.”

Prefixes such as “non,” “sub,” “micro,” “multi,” and “"ultra” are not independent words; they should be joined to
the words they modify, usually without a hyphen. There is no period after the “et” in the abbreviation “et al.” The
abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not
italicized).

IX. Conclusion

A conclusion section is required. Although a conclusion may review the main points of the paper, do not replicate
the abstract as the conclusion. A conclusion might elaborate on the importance of the work or suggest applications
and extensions. Note that the conclusion section is the last section of the paper that should be numbered. The appendix
(if present), acknowledgment, and references should be listed without numbers.

Appendix
Required appendices should appear before the acknowledgments.

Acknowledgments

An Acknowledgments section, if used, immediately precedes the References. Sponsorship information and
funding data are included here. The preferred spelling of the word “acknowledgment” in American English is without
the “e” after the “g.” Avoid expressions such as “One of us (S.B.A.) would like to thank...” Instead, write “F. A.
Author thanks...”

References

The following pages are intended to provide examples of the different reference types. All references should be in 9-point font,
with the first line flush left and reference numbers inserted in brackets. You are not required to indicate the type of reference;
different types are shown here for illustrative purposes only. The DOI (digital object identifier) should be incorporated in every
reference for which it is available (see Ref. 1 sample); for more information on DOIs, visit www.doi.org or www.crossref.org.

Periodicals
[1] Vatistas, G. H., Lin, S., and Kwok, C. K., “Reverse Flow Radius in Vortex Chambers,” AIAA4 Journal, Vol. 24, No. 11, 1986,
pp. 1872, 1873.
doi: 10.2514/3.13046
[2] Alyanak, E. J., and Pendleton, E., “Aeroelastic Tailoring and Active Aeroelastic Wing Impact on a Lambda Wing
Configuration,” Journal of Aircraft, published online 10 Nov. 2016.
doi: 10.2514/1.C033040
[3] Dornheim, M. A., “Planetary Flight Surge Faces Budget Realities,” Aviation Week and Space Technology, Vol. 145, No. 24,9
Dec. 1996, pp. 44-46.
[4] Terster, W., “NASA Considers Switch to Delta 2,” Space News, Vol. 8, No. 2, 13—19 Jan. 1997, pp. 1, 18.
All of the preceding information is required. The journal issue number (“No. 117 in Ref. 1) is preferred, but the
month (Nov.) can be substituted if the issue number is not available. Use the complete date for daily and weekly
publications. Transactions follow the same style as other journals.

Books
[5] Peyret, R., and Taylor, T. D., Computational Methods in Fluid Flow, 2" ed., Springer-Verlag, New York, 1983, Chaps. 7, 14.
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[6] Oates, G. C. (ed.), Aerothermodynamics of Gas Turbine and Rocket Propulsion, AIAA Education Series, AIAA, New York,
1984, pp. 19, 136.

[7] Volpe, R., “Techniques for Collision Prevention, Impact Stability, and Force Control by Space Manipulators,” Teleoperation
and Robotics in Space, edited by S. B. Skaar and C. F. Ruoff, Progress in Astronautics and Aeronautics, AIAA, Washington,
DC, 1994, pp. 175-212.

Publisher, place, and date of publication are required for all books. No state or country is required for major cities:

New York, London, Moscow, etc. A differentiation must always be made between Cambridge, MA, and Cambridge,

England, UK. Note that series titles are in Roman type.

Proceedings

[8] Thompson, C. M., “Spacecraft Thermal Control, Design, and Operation,” AIAA Guidance, Navigation, and Control
Conference, CP849, Vol. 1, AIAA, Washington, DC, 1989, pp. 103-115

[9] Chi, Y. (ed.), Fluid Mechanics Proceedings, NASA SP-255, 1993.

[10] Morris, J. D., “Convective Heat Transfer in Radially Rotating Ducts,” Proceedings of the Annual Heat Transfer Conference,
edited by B. Corbell, Vol. 1, Inst. of Mechanical Engineering, New York, 1992, pp. 227-234.

Reports, Theses, and Individual Papers

[11] Chapman, G. T., and Tobak, M., “Nonlinear Problems in Flight Dynamics,” NASA TM-85940, 1984.

[12] Brandis, A. M., Johnston, C. O., and Cruden, B. A., “Nonequilibrium Radiation for Earth Entry,” AIAA Paper 2016-3690,
June 2016.

[13] Steger, J. L., Jr., Nietubicz, C. J., and Heavey, J. E., “A General Curvilinear Grid Generation Program for Projectile
Configurations,” U.S. Army Ballistic Research Lab., Rept. ARBRL-MR03142, Aberdeen Proving Ground, MD, Oct. 1981.

[14] Tseng, K., “Nonlinear Green’s Function Method for Transonic Potential Flow,” Ph.D. Dissertation, Aeronautics and
Astronautics Dept., Boston Univ., Cambridge, MA, 1983.

Government agency reports do not require locations. For reports such as NASA TM-85940, neither insert nor
delete dashes; leave them as provided. Place of publication should be given, although it is not mandatory, for military
and company reports. Always include a city and state for universities. Papers need only the name of the sponsor;
neither the sponsor’s location nor the conference name and location is required. Do not confuse proceedings references
with conference papers.

Electronic Publications

Regularly issued electronic journals and other publications are permitted as references. Include the DOI if
provided; otherwise provide the full URL. Archived data sets also may be referenced as long as the material is openly
accessible, and the repository is committed to archiving the data indefinitely. References to electronic data available
only from personal websites or commercial, academic, or government ones where there is no commitment to archiving
the data are not permitted in the reference list.

[15] Atkins, C. P., and Scantelbury, J. D., “The Activity Coefficient of Sodium Chloride in a Simulated Pore Solution
Environment,” Journal of Corrosion Science and Engineering [online journal], Vol. 1, No. 1, Paper 2, URL:
http://www.cp/umist.ac.uk/JCSE/voll/voll.html [retrieved 13 April 1998].

[16] Vickers, A., “10-110 mm/hr Hypodermic Gravity Design A,” Rainfall Simulation Database [online database], URL:
http:// www.geog.le.ac.uk/bgrg/lab.htm [retrieved 15 March 2006].

Break website addresses after punctuation, and do not hyphenate at line breaks.

Computer Software
[17] TAPP, Thermochemical and Physical Properties, Software Package, Ver. 1.0, E. S. Microware, Hamilton, OH, 1992.
Include a version number and the company name and location of software packages.

Patents
Patents appear infrequently. Be sure to include the patent number and date.
[18] Scherrer, R., Overholster, D., and Watson, K., Lockheed Corp., Burbank, CA, U.S. Patent Application for a “Vehicle,” Docket
No. P-01-1532, filed 11 Feb. 1979.

Private Communications and Websites
References to private communications and personal website addresses are not permitted. They may, however, be

incorporated into the main text of a manuscript or may appear in footnotes.

Unpublished Papers and Books
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Unpublished works can be used as references as long as they are being considered for publication or can be located
by the reader (such as papers that are part of an archival collection). If a journal paper or a book is being considered
for publication, choose the format that reflects the status of the work (depending upon whether it has been accepted
for publication):

[19] Doe, J., “Title of Paper,” Name of Journal (to be published).

[20] Doe, J., “Title of Chapter,” Name of Book, edited by..., Publisher’s name and location (to be published).

[21] Doe, J., “Title of Work,” Name of Archive, Univ. (or organization), City, State, Year (unpublished).

Unpublished works in an archive must include the name of the archive and the name and location of the university or
other organization where the archive is held. Also include any cataloging information that may be provided.
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